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Lab 1: Measurement and Uncertainty
I. Before you come to lab...
A. Read through this handout in its entirety.
B. Download the Logger Pro software and learn how to use it.
1. Logger Pro for Mac or Windows can be obtained from
http://www.fas.harvard.edu/computing/download

You will need to log in with your Harvard ID and PIN. Logger Pro 3.5 requires Mac OS X version 10.3.9 or later, or
Windows 2000/XP/Vista.
If you have a PC or Mac but are unable to install Logger Pro, contact Joon for help. If you don't have a PC or a Mac
of your own, you can use Logger Pro on a computer in the Science Center computer lab to complete this part.
2. Familiarize yourself with the software.
a.
Start Logger Pro and click the

Open button.

b. Under the Experiments folder, find the sub-folder named "Tutorials."
c. Open the tutorial called "01 Getting Started."
d. Follow the instructions in the tutorial.
e. When you have finished, also complete the following subsequent tutorials:
05 Manual Data Entry
07 Viewing Graphs
08 Stats, Tangent, Integral
09 Curve Fitting
C. Pre-Lab Assignment
1. Complete the pre-lab assignment at the end of this handout.
2. Write your answers to the pre-lab questions on a separate sheet of paper. Make sure to write your name, your lab
TF's name, and your lab time at the top of your paper.
D. On the day of the lab...
1. Come on time to room 301.
2. Bring this handout.
3. Bring your completed pre-lab assignment. You will turn it in at the start of the lab period.
4. Bring a writing implement.
II. Background
What separates science from math, philosophy, or story-telling is the fact that science is grounded in experiment. Scientific
theories are tested and refined and are only retained when they prove to be an accurate description of the natural world.
So the study of physical science necessarily must involve some discussion of experiment.
The key concept that distinguishes experimental science from theoretical science is uncertainty. In an experimental setting,
it is just as important to specify not only what you know, but how well you know it. The purpose of this first lab is to
introduce some of the basic ideas behind the study of uncertainty.
A. Probability distributions
1. What is a probability distribution?
Probability distributions are functions which describe the possible values of a random variable and the likelihood of
each of those possibilities actually occurring. To take a very simple example, suppose you flip a coin and consider the
result of the flip as a variable which we'll call x. Then x can take two values, heads (x=H) or tails (x=T). The probability
distribution for the coin toss, which we call p(x), is pretty simple: p(H) = 1/2 and p(T) = 1/2.
2. Continuous variables
More commonly, we can specify the probability distribution for a continuous variable (rather than one that can only
take certain discrete values, like heads or tails). In general, to specify a probability distribution we need to specify a
value p(x) for each possible value of x. p(k) gives the probability of getting result x=k. (See Figure 1.)
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Figure 1: a probability distribution p(x), showing p(k) for a particular value k.
As an example, suppose we want to specify the probability distribution for the heights of adult women in the US. What
would this look like? Common sense, or qualitative reasoning, suggests that there is a typical average height, and
most women are approximately this height. A few are several inches taller or shorter than average. A very small
fraction are much taller (e.g. a foot taller) or much shorter than average. And the further you get away from the
average, the fewer women you expect to find that are that tall or that short. So if you wanted to specify p(x) for every
possible height x, p(x) would be highest in the middle (somewhere around 5'5") and lower on either side of that. For
values of x that are less than about 5' or more than 6', you'd expect p(x) to be very small indeed, because very short
or very tall women are rare. In short, you might expect to see something like this:

Figure 2: p(x), the hypothetical distribution of heights of adult women in the US.
The above graph is an example of a probability distribution function. It shows the relative likelihoods of finding women
of various heights. The value of p(x) is proportional to the probability of finding that value of x. So you can see that a
height of 65 inches (5'5") is about 16 times more likely than a height of 58 inches.
By the way, we still call x a "random" variable even though not all values of x are equally likely. In this case, "random"
doesn't mean we don't know anything about x; it just means that x isn't always going to have the same value. If we
know the probability distribution for x, we still can't predict the value of x, but we can predict the long-term occurrence
3-2

rates of different x values if we measure x many times. That's what we mean when we say "probability."
3. Area under the curve
Unfortunately, there's a bit of a problem with interpreting p(k) as the probability of getting the value x=k when x is a
continuous variable. If you want to know the exact probability of finding some specific value, it's actually zero! This is
because there are infinitely many possible values that x can take. So instead we have to ask, "what's the possibility of
finding a value in a certain range?" The answer is that the probability is equal to the area under the curve (see Figure
3).

Figure 3: Graphical representation of the probability of the height being between 66 and 68 inches.
Because the total probability of x having some value must be 1, that means the total area under the curve of a proper
probability distribution function must be equal to 1. This is called the normalization condition.
Mathematically, we can express the area under the curve p(x) between two values x=a and x=b as an integral, so:

4. Mean, median, mode
There are various numerical ways of describing the "middle" of a distribution. You may be familiar with these terms in
the context of a finite sample of data, but they are defined a bit differently when discussing a continuous probability
distribution:
a. The mean is just the average x value. However, the average is weighted by the probability function p(x). The mean
value of x is often denoted with angle brackets, like this: 〈x〉
b.
The median is the "middle" value. If the median is m, then x is 50% likely to be greater than m and 50% likely to be
less than m. Visually, the median divides the graph of p(x) into equal areas to the left and to the right.
c. The mode is just the single most likely value, i.e. where the function p(x) reaches a maximum value. (It is possible
to have more than one mode.)
5. Some examples
a. For a symmetric function like the one graphed above in Figure 2, the mean and median are equal to each other
(in this case, both are 65 inches). And because the distribution is peaked in the middle, the mode is also 65 inches.
However, Figure 4 shows an example of a symmetric distribution where the mode (actually two modes) is not
equal to the median and mean:
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Figure 4: A distribution with mean = median, but not mode.
b. The distribution from Figure 1 has three different values for the mean, median, and mode. The mode is the easiest
to find: it's the location of the peak, which is at x=2. To find the median, we have to find the point which divides the
graph into equal areas to the left and right. This is shown in Figure 5 (the area to the left of the median is shaded
red; the equal area to the right is unshaded):

Figure 5: Mean, median, and mode of the distribution from Figure 1.
The mean is trickier still; in order to find it, we have to evaluate a difficult integral. However, we know that the mean
should be to the right of the median: the median is the point where half of the probability is on either side, but the
half to the right is, on average, further away from the half to the left. So when we take the average of all of the
values to find the mean, we'll get something to the right of the median. (Performing the numerical calculations
gives 2 for the mode, 2.718 for the median, and 3 for the mean.)
6. Standard deviation
Another important characteristic of a distribution is the amount of "spread" it has around its mean value. The most
common way of describing this characteristic is a number called the standard deviation. The standard deviation is
usually denoted by σx. σ is the Greek lowercase letter sigma. A small σx means that the distribution is narrow, and
sharply peaked around its mean value; values far from the mean are very unlikely. A large standard deviation means
that the distribution is broad and shallow. Roughly, the standard deviation is the answer to the question "how far do
we have to go away from the mean before the x-values start to get really improbable?" Figure 4 shows two functions
with the same mean and different standard deviations. p1 is sharply peaked and has a standard deviation of 2.5
inches, and p2 is broader with a standard deviation of 5 inches.
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Figure 4: Two distributions with the same mean and different standard deviations.
B. Gaussians
1. There are many other distribution functions that occur in nature, but the most important one for our purposes is the
bell-shaped curve of which we have already seen examples. This function has lots of names: bell curve, normal
distribution, and Gaussian distribution. We'll use the name Gaussian (pronounced GOW-see-an) in this course. The
Gaussian distribution function has the following mathematical form:

The weird-looking factor outside of the exponential is there for correct normalization (to make the total area under the
curve equal to 1). The letters μ (mu) and σ (sigma) are the parameters that characterize the Gaussian; μ is equal to
the mean, and σ is the standard deviation.

Figure 5: The general Gaussian distribution G(x).
2. Rule of 68 and 95
Having an equation for the Gaussian is handy because we can numerically integrate it. If we do so, we get two
important results that you should commit to memory:
a. 68% of the total area under the curve falls between μ-σ and μ+σ, i.e. within one standard deviation of the mean.
So a variable that is distributed according to a Gaussian has about a 2/3 chance of being within one sigma of the
mean.
b. 95% of the total area falls between μ-2σ and μ+2σ. So it is rare for a Gaussian variable to have a value which is
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more than 2σ from the mean. This is illustrated in Figure 6.

Figure 6: Rule of 68 and 95, illustrated.
c. In this course, we'll generally be satisfied with 95% confidence about a result. However, in scientific research, in
order for the results of an experiment to constitute a real discovery, greater certainty is required. A common
standard is to require a "3σ result," meaning that the null hypothesis (i.e. the assumption that no discovery was
observed) was more than 3σ away from the observed results. Since 99.7% of the area under a Gaussian is within
3σ, such a finding means that the null hypothesis is very unlikely to be true. A 4σ (99.994%) or 5σ (99.99994%)
finding is even more compelling.
3. Why is the Gaussian important? It turns out that it crops up all over the place in experimental physical science. We'll
see why a little bit later.
C. Measurement and Uncertainty
1. Experimental science is about making measurements, but what's a measurement? That's a difficult question to
answer, but you can look at it this way: any physical quantity you try to measure (for example, the height of a person)
has a "true" value, but when you measure it, you won't necessarily get that true value, because all real-life measuring
devices are imperfect. There are two ways a measuring system can be imperfect:
a. It could be consistently wrong in the same way. For example, if you are using a ruler which is improperly
calibrated, so that all of your measurements will be 5% too short, it's clearly an imperfect ruler. This kind of
imperfection is called systematic error. Systematic error can, in principle, be eliminated by using properly calibrated
instruments and a well-designed measuring technique, but sometimes that's much easier said than done. A
measurement with little or no systematic error is said to be accurate.
b. It could be wrong in a different way every time. This is called random error. Unfortunately, random error is an
inevitable fact of life; no matter how good your instruments are, and no matter how careful your technique, you can
never eliminate random error. In this sense, "error" in science does not really mean the same thing as "error" in
English; you will have random error in your measurements, and it doesn't mean you made a mistake. If the
random error of a measurement is small, the measurement is said to be precise.

Figure 7: Schematic depiction of systematic and random error.
2. Since error is unavoidable, we could do one of two things:
1. Give up on ever trying to measure anything.
2. Learn how to describe error, and design experiments so that even if we can't measure something perfectly, we can
it least measure it as well as we need to.
We'll go with option 2. To give an example, say you're a carpenter trying to fit a door into a frame. You measure the
door and the frame with a tape measure. Rather than giving up because your tape measure can't tell you the height
of the door to the nearest nanometer, you realize that in order for the door to fit in the frame, the measurements
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really only need to be good to about the nearest sixteenth of an inch. So you make sure you get a tape measure that
is accurate to the nearest 1/16", and then you do the job.
3. Random error is the reason we can never be 100% sure of any measurement; hence, the word "uncertainty" is
essentially synonymous with random error.
4. So how do you figure out what the uncertainty is? Luckily, it turns out that a great deal of the time, the random error in
a measurement has an approximately Gaussian distribution. This is because there is a theorem of statistics that any
time you add together several random variables, you start to get something that looks like a Gaussian, even if the
individual random variables weren't Gaussian. This theorem, called the Central Limit Theorem, is an idea you'll
explore in the pre-lab. There are two important things to know about the theorem:
a. The sum of random variables technically doesn't converge to a true Gaussian unless there are an infinite number
of terms in the sum. Of course, in a real setting there are only a finite number of things going on.
b. However, the sum converges to something resembling a Gaussian very quickly. In particular, the part of the
distribution near the mean looks very Gaussian even after only a small number of terms in the sum; the tails
converge much more slowly, but because of the rule of 68 and 95, we're usually only interested in the parts near
the mean anyway. Most physical measurements have at least a few different random variables that contribute to
them: air currents jostling the physical system you're measuring, electronic noise in the measurement apparatus,
thermal fluctuations, etc. That's why you get approximate Gaussians.
5. Here's how we take advantage of the Central Limit Theorem to estimate uncertainties:
a. Repeat a measurement several times. Look at the distribution of the results, usually in the form of a histogram.

Figure 8: A sample histogram of some repeated experiment.
b. Guess the underlying Gaussian (or near-Gaussian) distribution. The more times you repeat the measurement, the
closer their distribution will resemble the underlying distribution, so the better your guess will be. How do we make
these guesses? Well, to determine a Gaussian you need to specify its mean and standard deviation. The best
guess for the mean is, unsurprisingly, the average of the repeated measurements. There's also a formula for the
standard deviation of a set of data points, and it turns out that this is also the best guess for the standard deviation
of the underlying distribution.

Figure 9: The same histogram, with the "best-guess" Gaussian drawn.
It's all rather straightforward—the only trick is to check to make sure your data points actually do resemble a
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Gaussian. After all, you can calculate the statistical mean and standard deviation of any set of data points, but if
you use them to "guess the Gaussian" when the data points themselves don't look anything like a Gaussian at all,
well, that's not very bright, is it? The way to check is to make a histogram of your data points and see if there is a
Gaussian that is a good fit for the shape of the histogram.
c. The mean of the underlying Gaussian corresponds to the "true" value of the measured quantity, as long as the
systematic error is small. Then we can use the rule of 68/95 to specify how well we know this "true" value.
D. Standard Deviation and Standard Error
1. If the data we take can be reasonably approximated by a Gaussian, then we know that about 68% of the
measurements will be within 1σ of the mean, and 95% within 2σ. By convention, we specify the uncertainty of our
guess as the range within which the value falls with 68% confidence.
2. Therefore, once we've taken enough measurements to have a good idea what σ is, we know that any single
measurement has a 68% likelihood to be within σ of the true value. So when using a single measurement as a guess
for the true value, the uncertainty of that guess is just σ, the standard deviation.
3. However, most of the time, we don't need to rely on a single value—after all, if we took repeated measurements, we
already know that the best guess we can make is not any one measurement but rather the mean of all the
measurement. This best guess is obviously better than a guess using only one value, and intuitively it should be a
better guess the more data points we have. So how good is this estimate? The answer is that it is within something
called the standard error, which has this formula:

The N in the formula is the number of data points included. The standard error (or SE) is the uncertainty of the best
guess; 68% of the time, the mean of all the data points will be within 1 SE of the true value, and 95% it will be within 2
SE's of the true value.
4. One way of thinking about the SE is to imagine taking many data sets, each of which contains N points. Even though
the individual data points are distributed according to a Gaussian with standard deviation σ, if you take the mean of
each set of N points, those means will be more tightly clumped around the true value of x. In fact, the means will also
be distributed according to a Gaussian, but one with a standard deviation of only σ/√N (the standard error). This is
also why the SE is sometimes called the standard deviation of the mean.
5. As you can see, for N=1 the standard error is equal to the standard deviation, which makes sense (the average of
one data point is just the data point). As you increase N, the SE goes down, meaning you are confining the 68%
confidence interval to a narrower range around the mean. However, the SE does not go down very quickly with large
N, as you can see from Figure 10:

Figure 10: The function 1/√N.
If you want to cut the uncertainty in half, you need to take four times as many measurements! This is fine if it means
increasing N from 1 to 4, but as N gets bigger you start to see rapidly diminishing returns; cutting SE from σ/5 to σ/10
requires increasing N from 25 to 100. At some point, you are better off trying to reduce σ by improving your technique
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or your measuring device; that will give you better bang for your buck than just taking a zillion repeated
measurements.
E. References
If you are interested in further reading on the subject of uncertainty, here are some suggested sources:
1. Taylor, John R. An Introduction to Error Analysis: The Study of Uncertainties in Physical Measurements. 2nd ed.
Sausalito CA: University Science Books, 1997.
2. Harrison, David M. Error Analysis in Experimental Physical Science. Dept. of Physics, University of
Toronto, 2004. http://www.upscale.utoronto.ca/PVB/Harrison/ErrorAnalysis/.
III. Introduction
A. This first lab is intended as a gentle introduction to the ideas of measurement and uncertainty that were discussed in the
Background section. There are two parts to the lab. In the first part, you'll try to measure the period of a pendulum using
several different techniques, and see how the uncertainty in the measurement depends on both the technique and the
number of times you repeat the measurement. In the second part, you'll apply what you've learned from the first part to
a similar task: measuring the period of your own heartbeat (i.e. the length of your pulse).
B. Objectives for this lab:
1. Understand what uncertainty is and what determines the uncertainty of a measurement
2. See how repeated physical measurements follow a Gaussian distribution
3. Learn to use Logger Pro to analyze data using histograms and Gaussian distributions
4. Apply your new knowledge to the measurement of your pulse
IV. Materials
A. Pendulum
B. Digital stopwatch
1.

2. Press the right button to start or stop the timer.
3. Press the left button to reset the timer to zero.
C. LabPro interface
1.

2. The LabPro interface is the green box that allows you to connect a wide variety of different sensors to the computer
via the Logger Pro software. Today, you'll be using it with the EKG probe.
D. EKG probe
1.
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2. The EKG sensor plugs into one of the sockets on the left side of the LabPro. It has three alligator clips, colored red,
black, and green.
3. To connect the EKG to yourself in order to monitor your heart's electrical activity:
a. If you are wearing long sleeves, roll them up past your elbow. If you are wearing a short-sleeved shirt underneath,
it may be more comfortable to just remove your overshirt entirely for this part of the lab.
b. With a dry paper towel, scrub your bare skin in the following locations:
(1) inside of right wrist
(2) inside of right elbow
(3) inside of left elbow
c. The goal is to remove dead skin and oil so that the electrodes can make good electrical contact with your skin. If
you need to, you can use alcohol swabs for further cleaning. Once the appropriate areas of skin have been
cleaned off, peel off three electrode patches and stick one to each area.
d. Clip the alligator leads from the EKG sensor to the tabs on the three electrode patches.

Black goes on your right wrist, green on your right inside elbow and red on your left inside elbow.
4. If you are interested in more detailed information about the EKG sensor, each work station has a copy of the technical
manual for the sensor.
V. Procedure
A. Before you begin...
1. Open the Photo Booth application and take a picture of your lab group. Drag it into the space below:

2. Type in your names:
B. Pendulum
In the first part of the lab, you will attempt to determine the period of a pendulum in several different ways. Actually,
though, what we are interested in is not necessarily the period itself, but the uncertainty in the determination of the
period, which will be different for each of the various ways in which you attempt to measure it.
1. Stopwatch measurements
Each member of your group should get a stopwatch and a notebook. You will each measure the period of the
pendulum in three different ways.
a. Measuring one period, endpoint-to-endpoint
(1) Time a single period of the pendulum using the stopwatch. You should start the watch at the instant when the
pendulum is temporarily still at an endpoint of its motion, wait for it to swing across to the opposite end, and
come back. Stop the watch at the moment when the pendulum returns to its original position and is temporarily
still again.
(2) Record the measured period in your notebook and repeat the procedure until you have measured the period
ten separate times each. You should not compare results with your lab partners during this process.
(3) When you have all returned to your station after collecting your data, open the Logger Pro file called Lab1Pendulum.cmbl (in the Lab1 folder on the Desktop). If the program prompts you about the sensor setup, click
on "Use File As Is."
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(4) Enter all of the results recorded by your group in the data table, under the column labeled 1T, endpoints. If
there are three of you in the group, there should be a total of 30 entries in the column.
(5) Create a histogram of the column 1T, endpoints. In Logger Pro, the histogram feature can be found under the
menu Insert→Additional Graphs. Once the histogram is displayed, you will need to double-click on the
histogram to set the options. Choose the correct column to display, and then try to make a reasonable choice
for the bin width. You don't want most of the bins to be empty or have only one data point, but neither do you
want the bins to be so wide that almost all of the values are in just one or two bins.
(6)
From the histogram, click on the

Statistics button to calculate the statistical mean and standard

deviation of your 30 data points.
mean =
std deviation =
(7)
Try fitting a Gaussian to the histogram by clicking the

Curve Fit button. In the box for "General

Equation," scroll to the bottom and select PS2 Gaussian. This function has three parameters: the amplitude A
(which we don't care about), the mean M, and the standard deviation S. What are the mean and standard
deviation of the best-fit Gaussian? (Note: you might find that the program calculates a best-fit value of S which
is negative. If so, ignore the minus sign; only S2 enters into the equation for the Gaussian, anyway.)
mean =
std deviation =
(8) Check to make sure these values are similar to the statistical mean and standard deviation that you found in
the previous step. If they are not, or if you are having other problems getting a Gaussian fit, you may need to
adjust the bin settings for your histogram. Ask a TF for help.
If everything has gone well, though, you should find that your histogram resembles a Gaussian (peaked in the
middle and roughly bell-shaped), in which case the values of M and S that you obtained from the fit are
probably a more useful indicator of the underlying Gaussian distribution than the statistical mean and standard
deviation of the original data points.
(9) Paste a screenshot of your histogram in the space below:

(10) Based on these 30 data points, what is your best estimate of the pendulum period? What is the uncertainty of
this estimate? Don't forget to specify the correct units in your answers.
period =
uncertainty =
(11) Save your work in both NoteBook and Logger Pro before moving on to the next part.
b. Measuring one period, middle-to-middle
(1) Using the stopwatches, go back and measure the period again. However, this time, instead of starting and
stopping the timer at an endpoint of the oscillation, focus on a fixed point near the middle, when the pendulum
is at the bottom of its swing, and wait for the pendulum to pass by that point. (One technique is to focus on a
line in the floor or wall behind the pendulum, and wait for the moment the pendulum string intersects your line
of sight.) Start the timer at that point, then wait until the next time the pendulum passes by the same point while
moving in the same direction before stopping the timer. (If you don't wait for it to be moving in the same
direction, you'll end up with only about half a period.)
(2) Record your measurement in your notebook. As you did before, repeat the measurement a total of 10 times
while your lab partners do likewise.
(3) Return to your station and enter the 30 data points into the data table in Logger Pro, under the column labeled
1T, middle.
(4) Create a histogram of the column 1T, middle, as before. Try fitting a Gaussian to it, and also calculate the
statistical mean and standard deviation. Record those values here:
mean from fit =
std deviation from fit =
statistical mean =
statistical std deviation =
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(5) Paste a screenshot of the histogram here:

(6) Based on these 30 data points, what is your best estimate of the pendulum period? What is the uncertainty of
this estimate? Don't forget units.
period =
uncertainty =
(7) Which is the superior measuring technique, endpoint-to-endpoint or middle-to-middle? How do you know? Can
you think of any reason this technique would be better than the other one?
(8) When you reach this point, talk to your TF. Discuss your answer to the last part with her and make sure
everyone is in agreement about which technique is better and why. Your TF might also pause here to copy
your measurements to the file containing the whole class's data.
(9) Save your work in both NoteBook and Logger Pro before moving on to the next part.
c. Measuring 10 consecutive periods
(1) Once you have agreed on which technique is better, go back and repeat the measurement using this
technique. However, instead of measuring a single period, wait for ten periods to elapse before stopping the
stopwatch. (Remember, if you are counting periods, the instant you hit the start button is period number "zero";
you can stop when you get to period ten. By now you should have quite a good idea of what the period is, so
you should expect your answer to be ten times as big. If it only looks nine times as big, you probably stopped
the watch one period too early.)
(2) Record the duration of ten periods in your notebook, and repeat the measurement ten times each.
(3) Enter the 30 data points into the Logger Pro data table under the column labeled 10T.
(4) Based on what you already know about the measurement process, and before performing any calculations,
what do you expect the standard deviation of these data points to be? Why?
(5) As before, make a histogram.
mean =
(6) Based on your answers to the previous two questions, what is your best estimate of the length of ten
consecutive pendulum periods? What is the uncertainty of this estimate? (Don't forget units.)
ten periods =
uncertainty =
(7) Assuming all periods are the same length, what is your best estimate of a single period based on your six
measurements of ten periods? What is the uncertainty on this estimate?
period =
uncertainty =
(8) Save your work in both NoteBook and Logger Pro before moving on to the next part.
d. Combined data from the class
(1) During the lab, the TFs will be collecting all of the measurements made by the class on the pendulum into a
single Logger Pro file. After everybody has finished taking data, the TFs will distribute histograms of the entire
class's data. If you get to this point before the data from everybody else is ready, continue on with the next
section and come back to this part when the class histograms are available.
(2) Paste the histogram of the class's measurements using the endpoint-to-endpoint technique here:

(3) Using the whole class's endpoint-to-endpoint data, calculate the period and uncertainty.
period =
uncertainty =
(4) Paste the histogram of the class's measurements using the middle-to-middle technique here:

(5) Using the whole class's middle-to-middle data, calculate the period and uncertainty.
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period =
uncertainty =
(6) Paste the histogram of the class's measurements of ten periods here:

(7) What is the best estimate of the pendulum period that can be made using any of the three class data sets?
Which data set does it come from? What is the uncertainty of the estimate?
(8) Save your Lab1-pendulum.cmbl file in Logger Pro. Then go to the finder and drag the saved file into the space
below in order to attach it to you lab report:

(9) Save your work in this NoteBook file before moving on.
2. Sonar detector measurements
a. The TFs will also be using a sonar motion detector to record the motion of the pendulum for 60 seconds. They will
give you each a Logger Pro file called Lab1-sonar.cmbl which contains the data from the motion detector.
b. Open the file called Lab1-sonar.cmbl. If Logger Pro complains that it can't find the motion detector, click on
"Continue without Data collection."
c. You should see a nice sinusoidal trace of the pendulum's position. Paste a screenshot of that trace here:

d. Click on the graph. From the Logger Pro menu, select Analyze→Interpolate. A box will appear showing the
position of the pendulum at whatever time corresponds to the position of the mouse. You can also move the
mouse cursor one pixel at a time by pressing the left and right arrow keys.
e. By moving the mouse cursor back and forth and looking at the position readings, you can measure the length of
each of the roughly twenty periods visible in the graph by examining the successive times at which the position
trace does certain repetitive things. In fact, even here there are two ways of defining the beginning/end of a period.
(1) What procedure for determining periods corresponds to the "endpoint-to-endpoint" technique you used with
the stopwatch?
(2) What procedure corresponds to the "middle-to-middle" technique?
f. Using one of these techniques, write down the times at which the corresponding event occurs in each period
throughout the trace. You should have at least twenty such times.
g. Go to page 2 of the Logger Pro file and enter these times into the data table there, under the column Times. As
you do so, the column labeled Periods should automatically fill itself in with the time elapsed between each point
and the next.
h. Analyze the data in the Periods column and determine your best estimate for the pendulum period using the sonar
data. What is the uncertainty of this estimate? Show your calculations along with any graphs you used here:

i. Save your work in Lab1-sonar.cmbl and attach the file below:

j. Save your work in NoteBook.
C. Heart rate
In this part of the lab, you will attempt to use what you've learned about measurement to determine your heart rate.
Actually, rather than "heart rate" (which is usually reported in bpm, or beats per minute), you will measure the length of
an average pulse, very similar to the way you measured the length of a pendulum period in the first part. Remember,
though, that although the pendulum is extremely regular, your heartbeats are not quite as regular—each pulse is not
exactly the same length as the previous one, although it is pretty close.
1. At some point during the lab period, each group member should measure their own heart rate in two different ways:
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using a stopwatch, and using the EKG probe.
a. You will have to determine what procedure you will use to make the stopwatch measurement. For example, you
could count how many pulses elapse in a fixed time; or you could time how long it takes for a fixed number of
pulses; or you could measure the length of a single pulse and repeat the process many times; etc. Your goal is to
measure your heart rate as precisely as possible, with the constraint that the measurement itself should take no
more than 60 seconds. If you have already completed the pendulum part of the lab, hopefully you now understand
how to optimize your procedure.
b. For the EKG probe, you will each record your EKG for 60 seconds while you are here in the lab and save it to a
Logger Pro file. However, the analysis of the EKG data will be done outside of the lab, as part of this week's
homework.
2. Using a stopwatch
a. Discuss with your lab partner(s) and decide on what procedure you are going to follow. If you have questions
about what you should do, talk to your lab TF.
b. Locate your carotid pulse, on either side of the front of your neck, just below the angle of the jaw. Place two fingers
there and gently move them around until you feel the rhythmic beating of your pulse. Use only very light
pressure! Pressing firmly on the carotid artery can cut off blood flow to your head.

c. If you can't locate your carotid pulse, you can try to find a different pulse. The radial pulse (inside of the wrist, on
the thumb side) is a good alternative choice. You will have to relax your hand and wait several seconds before you
begin to feel the pulse.
d. Remember that your heart rate depends on things like how relaxed you are, whether you have recently been
doing something physical strenuous, whether you are sitting or standing, whether you just had a cup of coffee, etc.
Try to measure it when you are sitting down and have been relaxed for a few minutes. If you have spent some
time standing and then sit down and immediately measure your pulse, you will find that you are aiming at a moving
target—your pulse will gradually slow down while you are trying to measure it.
e. Once you have located the pulse, get a stopwatch and make your measurement(s).
f. Record your results, along with an explanation of your technique, here. Make sure that each group member
records their individual results.
(1) Name:
(a) Time of one pulse =
(b) Uncertainty =
(2) Name:
(a) Time of one pulse =
(b) Uncertainty =
(3) Name:
(a) Time of one pulse =
(b) Uncertainty =
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3. Using the EKG probe
a. Open the Logger Pro file called ekg.cmbl. (If necessary, save your work in whatever Logger Pro file is already
open. Logger Pro can only have one file open at a time.)
b. Immediately go to the File menu and select "Save As..." to save a copy of this file under a different name. Rename
is from "ekg" to "ekg-[your name]" in the same folder.
c. Set up the EKG probe as explained above.
d.
Click the

Start button to collect data.

e. It may take 10 or 15 seconds for the EKG trace to start to appear on the screen, but eventually it will. The data
collection will run for 60 seconds. Make sure that at least 30 seconds' worth of actual data is there. If you are not
sure whether it worked, ask your TF to check for you.
f. When the data collection is done, you can unclip the alligator leads from the electrode patches, then discard the
patches.
g. Save your Logger Pro file before loading either a new EKG file or the file with pendulum data.
h. Attach your Logger Pro file here:
(1) Name:
Click and drag your Logger Pro EKG file from the Finder into the space below:

(2) Name:
Click and drag your Logger Pro EKG file from the Finder into the space below:

(3) Name:
Click and drag your Logger Pro EKG file from the Finder into the space below:

i. You will analyze the data you have collected as part of this week's homework assignment. You do not have to
complete it during the lab.
VI. Conclusion
A. Congratulations! You've reached the end of the first lab.
B. Your TF will give you instructions on how to submit your lab report.
VII. Pre-Lab Assignment
A. Before doing the pre-lab assignment, read through this handout. Download the Logger Pro software and work through
the recommended tutorials.
B. Download the file prelab1.cmbl from the course website. There is a link on the Laboratory page of the course website.
Right-click on the link and save the file to your computer.
C. Open the file in Logger Pro and follow the instructions.
D. When you reach the end, answer the following questions (on a separate sheet of paper):
1. Briefly sketch each the shapes of the first two histograms (Die #1 and Sum 2). Why isn't the second one flat? Can you
guess the shape of the "true" underlying distribution for the sum of two dice?
2. Qualitatively describe how the shape of the histogram changes as you increase the number of dice in the sum from
one to five. Does it start to look like any other shape you've seen before?
3. In the lower left of each page of the Logger Pro file is a box that says "N 1000." N is the number of times each die is
rolled (i.e. the number of rows in the data table). You can click the up and down arrows in this box to change the
value of N in steps of 100. Does anything interesting happen to the histograms if you increase the value of N? What if
you decrease it?
E. If you are having trouble with the software or have questions about anything in this handout, please contact your lab TF
for help.
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